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Abstract:  The present system for Ration shops has many disadvantages. They have low processing speed. They have less man 

power, so the filling and the packing of products takes a lot of time. And some of the ration dealers weigh the products less compared 

to what was requested by the customer. This paper aims in providing an automatic filling machine which fills all the products 

requested by the customer, simultaneously, thus reducing the time consumed per customer. This machine works on the feedback of 

loadcell, which provides high weight accuracy, thus eliminating the risk for the customers getting cheated. 

 

Index Terms – Loadcell, ESP8266, Servomotor, Ultrasonic sensor, ESP8266 webserver 

I. INTRODUCTION 

PDS (Public Distribution system) or ration distribution system provides supply of rice, ragi, wheat, cooking oil to the Below 

Poverty Line on a monthly basis. Currently, people have to carry their smart card to the ration shops to book these products. The 

present PDS system has a lot of drawbacks. The processing speed in low as the ration shop keeper manually fills and packs each 

product requested by the customer one by one. Because of low processing speed, in case of long queue, people can get frustrated. 

Some of the ration shop keepers weigh the products less compared to what was requested by the customer resulting in fraudulence. 

Smart card should be scanned to verify the customer details. But in many shops the smart card reader is not reading the cards. And 

in many cases, people tend to forget taking the smart card with them. 

 

In this paper we have designed a smart ration dispensing system based on IOT, which automatically fills the products requested 

by the customers simultaneously. The system works based on the load cell feedback to provide high weight accuracy. This eliminates 

the risk of customers getting cheated. All the government issued cards such as smart card, AADHAR card, license etc. are linked to 

the phone number. In the proposed system we are verifying the customer using their phone number, thus eliminating the need to 

physically carry the smart card. A webpage is developed for customer verification and to book products(inputs). And after product 

booking is done, SMS is sent to the customer’s phone number. 

II. LITERATURE SURVEY 

Srinivas Hebbar [3], explains a system where each customer will be given a RFID card. The RFID card will have a finger print 

match stored in the database. The data of the user will be stored in the SD card along with the balance for respective cards. RFID and 

finer-print are used for customer verification. If verified, valve of containers containing the products open one by one till the particular 

quantity is filled. Drawback: The quantity is predefined depending on the balance, and the products are not filled simultaneously in 

this system. 

 

Sneha Ingale [4], explains a system based on RFID technology. A customer database is created and stored in the arduino 

microcontroller. The RFID is used to verify the customer details and after successful verification customer enters the what product 

they want and the quantity using keypad. After delivering proper material to the customer, the microcontroller sends the information 

to the controller. Drawback: The products are filled manually by the shopkeeper so there is a risk for inaccuracy in the quantity 

requested by the customers. The process is very slow and time consuming. 

 

Miss A Jesheenaa [1], explains a system where the database of the customers is stored in the arduino microcontroller and the 

customer is verified using RFID technology. GSM module is used to communicate the information of product distribution between 

two persons or more to update the information depending on the requirements. 
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III. PROPOSED METHOD  

To provide a solution to the various problems faced, this paper proposes a IOT based Smart Ration Dispensing System based on 

Loadcell Feedback. It has a series of containers with feeder inlet to fill the container with the ration goods (example: Rice, sugar, oil, 

etc). Each container has an outlet whose opening or closing is controlled by servo motor wirelessly. A database is created with the 

customer details along with the phone number. We are using phone number to verify the customer because all the government issued 

ID cards are linked to the phone number along with their image. This eliminates the need to physically carry the smart card which is 

required in the present system. Using load cell provides high weight accuracy. The overall system setup is shown in Fig.1. 

 

 
Figure 1. Overall system setup 

3.1 Block diagram 

The block diagram of IOT based Smart Ration Dispensing System based on Loadcell Feedback is shown in Fig.2. It consists of 

NodeMCU, Servomotor, loadcell, loadcell amplifier, buzzer and ultrasonic sensor. 

 

 
Figure 2. Block Diagram 

 

3.2 Block diagram description  

The program is loaded inside the NodeMCU which is a microcontroller with WIFI capability. The NodeMCU has a station 

(STA) mode using which it can connect to the existing WIFI network and can act as a HTTP server with an IP address assigned by 

that network. It serves the website with which the shopkeeper operates. Servomotor, ultrasonic sensor, loadcell amplifier and buzzer 

is connected to NodeMCU. When a customer needs to buy product from the ration shop, the shopkeeper enters the customer’s 

phone number in the website. The customer details are fetched from a database and displayed on the screen for verification. The 

database used here is firebase database. It is a real time cloud hosted database. Once the customer is verified, the shopkeeper selects 

and enters the products along with quantity, in the appropriate input fields in the website. For example, consider the customer 

requested 1kg of rice. Once these details are given to the input field and payment is done, the input field data is sent wirelessly to 

the NodeMCU. Consider the example of 1kg. Now NodeMCU will open the container outlet using a servo motor. The product will 

flow out from the container, into the bowl placed above the load cell. Load cell feedback is given to the NodeMCU as input. This 
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loadcell feedback will be continuously compared to the data(1kg) wirelessly transferred from the website. When they both matches, 

NodeMCU closes the container outlet using the servo motor and buzzer activates for one second indicating the process is complete. 

An SMS is sent to the customer. 

IV. HARDWARE AND SOFTWARE COMPONENTS 

The hardware components used are: 

• Generic ESP8266 NodeMCU 

• 5Kg Load cell 

• HX711 Amplifier 

• Mg996R High torque metal gear servo motor 

• Active Buzzer Module 

• HC-SR04 Ultrasonic module 

• OTH17 Power supply module 

The software tools used are as follows 

• Arduino IDE 

• Firebase 

• IFTTT 
 

4.1 NodeMCU 

Also known as Node Microcontroller Unit, it is a low-cost IOT platform. It integrates 802.11b/g/n HT40 Wi-Fi transceiver, so 

it can not only connect to the internet, but it can also set up a network of its own, allowing other devices to connect to directly. 

Table 1 gives the NodeMCU specifications. 

Table 1. NodeMCU Specifications 

Microcontroller 32-bit ESP-8266 

Clock frequency 80 MHz 

Internal RAM 128KB 

Flash 4MB 

Operating voltage 3V to 3.6V 

Digital IO Pins 11 

Analog in pins 1 

 

4.2 Load Cell 

Load cell is used to measure weight. It is a transducer used to convert force or pressure into electrical output. They are made up 

of very thin wire or foil and arranged in a grid pattern in such a way that it produces a linear change in resistance when strain is 

applied among one axis. A typical load cell consists of four strain gauges connected in a wheat-stone bridge. The system is designed 

in such a way that at normal conditions the bridge remains balances, and hence no electrical output is produced. One end of the load 

cell is fixed firm to the base and the other end is free. The load is applied on the free end. 

Since the load is applied on the free-end a deformation takes place in strain gauges. This changes the resistance of the gauges 

and makes the wheat-stone unbalanced and this in turn produces electrical output. This output produced is very small. It cannot be 

read by a microcontroller directly. An amplifier should be used to amplify the signal produced by the load cell, and fed to the 

microcontroller. 

 

4.3 HX711 Amplifier 

This is used to amplify the low electrical signals produced by the load cell. It uses a 24-bit high precision A/D chip. It is used 

to interface load cell with the microcontroller. Table 2 gives the HX711 specifications. 

Table 2. HX711 Specifications 

Operating Voltage 5V 

Operating Current <10 mA 

Refresh Frequency 80 Hz 

Data Accuracy 24bit 

 

4.4 Servo Motor 

Servo motor is an assembly of four things: DC motor, a gear reduction unit, a position- sensing device and a control circuit. 

Position sensing device is usually a potentiometer. When the servomotor receives a control signal that represents a desired output 

position, the DC motor is powered until its shaft turns to that position. It uses the position sensing device to figure out the shaft 

position, so it knows which way the motor must turn to move the shaft. Table 3 gives the Mg996R servomotor specifications. 

Table 3. Mg996R Specifications 

Operating Voltage 5V 

Rotation 0 -180 degree 

Stall Torque 9.4Kg/cm 

Operating Speed 0.19sec/60degree 

 

4.5 Active Buzzer Module 

The buzzer module has an internal oscillator. This generates a tone when an input signal is given to it. The active buzzer module 

has an operating voltage of 5V. 
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4.6 HC-SR04 Ultrasonic Module 

The ultrasonic sensor can convert electrical energy into sound waves and vice versa. It is used mostly to measure the distance. 

The ultrasonic sensor has a transmitter and receiver. The transmitter generates eight acoustic wave bursts and initiates a time counter. 

When this wave hits on an object it gets reflected. The receiver picks up this reflected wave. 

The distance between the object and the sensor is given by the formula, 

 

Distance = Speed x time 

Speed is 330m/s and time taken is calculated by the sensor’s inbuilt timer. Table 4 gives the ultrasonic sensor specifications. 

 

Table 4. Ultrasonic sensor Specifications 

Operating Voltage 5V 

Operating Current <15mA 

Operating Frequency 40kHz 

Angle Covered <15 degree 

Distance Measured 2cm to 4m 

 

4.7 OTH17 Power Supply Module 

Except nodeMCU all other components mentioned above works on 5V. NodeMCU doesn’t provide 5V output. So, we use an 

external power supply. The OTH17 takes in an input voltage of 6.5 to 12 VDC and provides both 3.3V and 5V output power supply. 

It also has a push button to tun on/off the whole module. 

 

4.8 Arduino IDE 

To program the nodeMCU we use Arduino IDE software. The Arduino Integrated Development Environment - or Arduino 

Software (IDE) - contains a text editor for writing code, a message area, a text console, a toolbar with buttons for common functions 

and a series of menus. 

 

Programs written using Arduino Software (IDE) are called sketches. These sketches are written in the text editor and are saved 

with the file extension “.ino”. The message area gives feedback while saving and exporting and also displays errors. The console 

displays text output by the Arduino Software (IDE), including complete error messages and other information. The bottom righthand 

corner of the window displays the configured board and serial port. The toolbar buttons allow you to verify and upload programs, 

create, open, and save sketches, and open the serial monitor. 

 

Before uploading the sketch, the correct items are selected from the Tools > Board and Tools > Port menus. On Windows, it's 

probably COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB board). After the correct serial port 

and the board is selected, the upload button in the toolbar is pressed. The Arduino software will display a message when the upload 

is complete, or show an error.  

 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or manipulating data. To use a library in a 

sketch, the Sketch > Import Library menu is selected. This will insert one or more #include statements at the top of the sketch and 

compile the library with your sketch. Because libraries are uploaded to the board with your sketch, they increase the amount of 

space it takes up. If a sketch no longer needs a library, simply delete its #include statements from the top of your code. There is a 

list of libraries in the reference. Some libraries are included with the Arduino software. Others can be downloaded from a variety 

of sources or through the Library Manager.  

 

4.9 Firebase 

Firebase is a backend developed by google. It offers real time database, different APIs, multiple authentication types and hosting 

platforms. The firebase Realtime database is a cloud-hosted NoSQL database that’s lets us to store and sync data between users in 

real-time. It has real time syncing that makes it easy for the users to access data from any device and helps collaborate with one 

another. When the users go offline, the Realtime Database SDKs use local cache on the device to serve and store changes. When 

the device comes online, the local data is automatically synchronized. 

 

4.10 IFTTT 

IFTTT is a software platform that connects apps and devices. It works on If THIS then THAT. THIS is event and THAT is the 

action. So, when an event occurs an action is performed. In this case, the event is ‘booking the product’ and the action is ‘sending 

SMS to the customer’.  

 

V. RESULTS AND DISCUSSION 

 Atter program is uploaded to NodeMCU, the IP address of the NodeMCU is entered in a web browser to open the webpage. 

Figure 3 shows the root webpage served by the webserver. 
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Figure 3. Webserver webpage 

 

 The phone number is entered to fetch the customer details. Figure 4 shows the details of the customer displayed after the 

phone number is entered to access the database. 

 
Figure 4. Customer details displayed 

 

 The required quantity is entered. And after submit button is clicked the product is filled in a bowl placed above the load 

cell. Figure 5 shows the Shopkeeper input the required quantity requested. 

 
Figure 5. Entering the quantity is 100 gm 

 

 An SMS is sent to the customer. Figure 6 shows the SMS sent to the customer. 
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Figure 6. SMS sent to customer 

 

 The bowl with the product is taken to verify if the quantity is correct. 

 
Figure 7. Weight 

 

 When the product inside the container goes below a particular value, an alert is displayed on the webpage. Figure 8 shows 

the level alert displayed on the webpage. This indication will be automatically removed once the container is refilled. 

 
Figure 8. Level Alert 

 

 The transactions are stored in the database and accessed whenever required. Figure 9 shows the sale log. 
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Figure 9. Sale log  

VI. CONCLUSION 

This work presents the design for IOT based ration dispensing system in which we are eliminating the need to carry a physical 

smart card for customer credentials verification. The system works based on loadcell feedback to provide accuracy. The results are 

promising. Since the products are filled simultaneously the time consumed per customer is reduced. 
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